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These notes were taken by Linda Hartsock.  The text is derived from hand-written notes and is, therefore, not verbatim.  Please feel free to let me know if you see any glaring errors.  I would encourage other conference delegates to also share their notes as I’m sure we all have different ideas of what we consider “note-worthy.”
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Group Photo Op with Secretary Rice

Loy Henderson Conference Room, 1st Floor

The OMS Selection Boards (FS-6 to FS-5): The Board’s Perspective

Eric Nelson, A/GSSI, Joyce Harley, S-S/EX

· Many people they would have like to promote, but not enough numbers.

· Impressed with the technical skills at senior levels.

· Remember that entry level are judged against the precepts of mid-level for promotion.

· There is a lot of “reinventing the wheel.”  The Department should identify “best practices” and make them standard. 

· Tasker logs – repetition.  Why are Front Offices creating and using tasker logs and sending things to Pol/Econ, and Pol/Econ creating their own tasker logs to track them.  Should be able to standardize and share.

· OMS are developing solutions.  Leadership Skills – leading colleagues to adopt these new solutions.  Reach out beyond your section – Share your skills & solutions Mission wide.

· Share information within post, as well as Post to Post.

· Precepts at mid-level – must demonstrate how you integrated or shared lessons learned from training.

· Document your training – have it put on your employee profile (EP).

· Work Requirement Statements should be based on the core precepts.

· EER – provide examples based on the precepts.

· Emphasize the shade of difference between entry & mid-level, or mid-level & senior.

· Take on extra projects/duties outside of your Work Requirement Statement.

· Continuing responsibility – Maintain SIPRNet.  Specific Objective – teach section how to do it.

· Create an EER folder on your computer or your Outlook and put info or notes to yourself throughout the year on your accomplishments.  That way you won’t have to go scrounging for examples at EER time.

· Areas for improvement – acknowledge it in your statement.  It is important to create opportunities to show improvement in your area for improvement from last year.

· A serious Area for Improvement strengthens the validity of an EER.

· A strong Area for Improvement is a good thing – especially if you can show improvement.

· Throwaway Areas for Improvement can be bad.  Read them carefully.  A bad throwaway would be “lacks attention to detail”, or anything in interpersonal skills.

· Strive to become a valuable employee – NOT an indispensable employee.  Train others, prepare your back-up, organize for others.  If the office falls apart when you are gone, you are not doing your job.

· Stay away from clichés (ie “the glue that holds the section together”).

· Consider finding the book “Effective Phrases for Performance Appraisals”.  Can be ordered on line.

· Line up your last 4 or 5 EERs and read them together.  That is what the panel does.  They are required to look at the last 5 years, but can look at more.

· Add letters to your file in DC to support statements.

· White space – quality over quantity.  Concise in fewer words that get the point across.

· Get your EER done before Rater/Reviewer get tired.

· Provide your opinion.  This is your EER.  You are responsible for the final product.

· Supervisory duties should definitely be mentioned.  It is rare for an OMS to have supervisory duties so take advantage of it.  However, it must talk about what kind of supervisor you are.

· If you create an SOP make sure it is available for continuity.

· Keep letters from SecState or other visits to corroborate TDYs or visits.  Focus on what you did that was special.  How did you contribute?  Quality over quantity.

· Share information learned at this conference with others; then be sure to add that you shared to your EER.

· Schedule a language test at FSI at the end of your tour to get your level on your record.  An FSI test score corroborates Rater’s comments.  Native speakers should also test.  Get it on your EP.

· Leadership Skills – Representational skills (host lunches, etc. for your host-country counterparts).  Ask for rep funds, especially end-of-year funds when they are trying to use them all.

· Openness to dissent – when to make your opinion known.

· Community Service & Institution Building – look for opportunities.

· Suicide box should show that you are enjoying your job.  Steer away from adverse comments.  Say positive things.

· Suicide box – be careful in discussing something important that doesn’t have corroboration from Rater/Reviewer.  If it is important, have them include it as well.

· It is a nice courtesy to thank your Rater & Reviewer in your statement.

· Suicide box – I is good to put examples in employee statement.  However, if it is only stated in the employee statement and not corroborated by Rater/Reviewer it doesn’t carry as much weight.

· Do not reference health issues or retirement status, age, etc.  Inadmissible comments are not allowed in the employee statement either.

· Share your statement with colleagues you trust.

· We are all looked at as individuals.  If you perform at the next step level it doesn’t matter where you are.  However, special consideration is given for hardship posts, especially Iraq, Kabul, etc.  It is similar to diving – your score depends on not only how well you execute the dive, but also the difficulty of the dive.  Danger posts do matter.

· Promotion numbers vary from year to year due to attrition, etc.  Depends on how many positions at each grade are open.

Office of Equal Emp0loyment Opportunity and Civil Rights

Ms. Jacqueline Canton, Chief, EEO Counseling Coordinator, 

Office of Conflict Resolution, S/OCR

3 FAM 1500

http://SOCR.state.gov

· Don’t give glowing evaluation where it’s not deserved.

· EEO counselors must receive special 32 hour training.

· EEO FSN Liaison – serves as a bridge between Management & the EEO Counselor.  Someone who is respected on both sides an can explain the system.

· Each post should have at least 1 or 2 EEO Counselors.  Approximately 1 counselor for every 50 people.  Smaller posts can “piggyback” on larger posts.

· Settlements come out of post & Bureau budgets.

· Learn to disagree agreeable.

· We have the ability to influence what goes on in our office.

· Diversity awareness training is mandatory for everyone.
Donna Stoffer, Office Management Training (OMT) Director

Begin with the End in Mind

Based on the 7 Habits of Highly Effective People
· Make plans to reach your goals.

· Be prepared.  There are over 3,000 Fastrac classes available.

· Maximize your own influence over reaching your goals.

· To resist the IT advances is career suicide.

· Confirm your position with facts.

· Be positive – don’t get caught up in negativity.

· Adversity serves a purpose in your personal growth.

What the Family Liaison Office (FLO) Can Do For You

Ann Greenberg, Director, FLO

The FLO Mission is to:

· Improve the quality of life by identifying employee/family issues an advocating for programs and solutions;

· Provide a variety of client services, including employment counseling, employee and family member briefings, education resources and youth assistance, crisis support and referrals; and

· Extend quality of life services to our overseas communities by managing the worldwide Community Liaison Office (CLO) program.

The Family Liaison Office provides a number of services, including:

· Family Member Employment

· Coping with Post Crisis and Evacuations

· Family Support Services

· Community Liaison Office (CLO) Program

· Expeditious Naturalization

· Education and Youth Services

· FLO Outreach Programs

The Community Liaison Office at Post has eight areas of responsibility:

1. Employment Liaison

2. Crisis Management & Security Liaison

3. Education Liaison

4. Information and Resource Management

5. Guidance and Referral

6. Welcoming and Orientation

7. Community Liaison

8. Events Planning

The Family Liaison Office also offers a large number of publications on their Web Sites:

Internet – http://www.state.gov/m/dghr/flo
Intranet – http://hrweb.hr.state.gov/flo/index/html
The OMS Conference delegates received several handouts from the FLO Director.  I would be happy to share them with anyone interested. 

Meet & Greet Happy Hour at Hyatt Hotel for Conference delegates and invited guests.

Among the invited guests were members of a new-hire class who did not yet know their assignments.  They were excited to talk to the delegates and were full of questions about life in the Foreign Service and at the various posts.  We welcomed them to the Foreign Service family.

Tuesday, October 4

QuickHire:  The Automated Hiring Process and the Career Development Path – How Will It Affect You?

Frederike Barron & Debra Shea, FS OMSs

Not currently hiring OMS.  The register should be open sometime in 2006.  New OMS applicants will have to already have the core Microsoft certificates to be considered.

Career Website – Direct any inquiries to the www.careers.state.gov website and click on Specialists.  Scroll down and you see all nineteen Specialist categories listed.  There is also a button one can click to sign up for immediate notification for when a Specialty opens again.

Subject Matter Experts (SMEs) are experts on a specific Specialty who volunteer their services to assist with the candidates’ oral assessments.  Office Management Specialists at the FP 5 level are eligible to serve as OMS SMEs and are selected at the discretion of the Recruitment Officer.

If you are in DC on assignment during an OMS Recruitment Cycle, consider serving as a Subject Matter Expert.  You will have a real impact on who your colleagues will be, and it looks good on your EER!  Contact Recruitment Officer Linda O’Brien in HR/REE/EVAL to express interest.

Overview of 

Principles of Career Development for the Foreign Service Office Management Specialists:

· Operational & Technical Effectiveness, including a breadth of experience over several regions and/or functions

· MANDATORY:  Obtain a minimum of 3 computer training certifications.  OMSs will be required to maintain proficiency in new software applications as determined by service needs.

· ELECTIVE:  Obtain additional computer training/certifications 

· ELECTIVE:  Serve on Operational/Crisis Response duty

· Leadership and management effectiveness;

· MANDATORY:  Take Leadership Training

· ELECTIVE:  Supervisory responsibility (documented in WRS & EER)

· Sustained professional technical skills and language proficiency;

· MANDATORY:  Achieve a 3/3 in a World Language or a 2/2 in a Hard or Super hard Language as tested by FSI (depending on when tenured)

· ELECTIVE:  Cross-functional experience or out-of-skill-cone assignment

· ELECTIVE:  Professional development and training (minimum of two additional management courses)(e.g. Interpersonal and/or teamwork skills training.)

· ELECTIVE:  Professionally related training at a school of higher education

· Responsiveness to Service needs

· MANDATORY:  Service at a 15% or greater hardship/differential/danger pay post

· ELECTIVE:  Serve in Executive Offices as OMS to COM, DCM, Under Secretary, Assistant Secretary or DAS

· ELECTIVE:  Serve in an officially designated Critical Needs position

· Serve one tour at an unaccompanied post

This will be a self-certification process.  Be sure EP+ has the correct information on what you have done.

Following the presentation on the Career Development Path, “Breakout Sessions” were held in which the delegates discussed the CDP and made suggestions.  Each delegate attended two of the eight breakout sessions.  Briefings on the discussions were presented on Wednesday morning.

Why do OMS not want to bid on Front Office positions?

During one of the “breakout sessions” I attended someone mentioned that they did not ever want to bid on a Front Office job.  I took the opportunity to ask, “Why do people not want to bid on Front Office positions?”

The answers I received from the group at the table were:

· Long hours

· “personalities” – especially Political Appointees

· Prisoner of your desk; Can’t be “spared” to go for training or TDY opportunities

· No time available to serve on committees

· Timing – can’t schedule your movements until Ambassador designate has been confirmed; Ambassador can leave post early, at which point the OMS must also leave post, ready or not

· Doesn’t guarantee promotion

I addressed those issues then, and at the conference closing session, as follows:

· Long hours – Yes, the Front Office frequently requires working long hours.  However, I know of several offices in the Department where they also work long hours.  OMSs are entitled to receive overtime pay.  Frequently posts ask that you take comp time instead due to budget shortages.  However, if an OMS is regularly working overtime, he/she would more than likely have use-or-lose hours anyway and it would not make sense to take comp time.  Each of my Front Office supervisors have agreed to pay me for the hours I work.

· “Personalities” – There can be difficult people in any office.  The good thing about most offices is that you rarely arrive at the same time so you will probably not have to spend a full tour with them.  In the case of Ambassadors, however, you generally arrive with the Ambassador and depart when he/she does.  However, there are solutions available.  If you just can’t work with someone, a “friendly divorce”, contrary to some opinions, will not ruin your career.  I curtailed from one such situation and was promoted the following year.

· Prisoner of your desk – frequently we are our own worst enemy.  I am a work-a-holic and rarely leave my desk, not even for lunch.  At times, when there is only one OMS in the Front Office and/or no one else to cover, yes, we do have to stay in the office.  However, when there is both an AMB OMS and a DCM OMS, or when there is an Econ or Pol OMS, or a cleared EFM who can sit in for a short time, there should be no reason that Front Office OMSs can not leave the office.  My Ambassador frequently exhorts me to go to lunch, or at least to go for a walk.  

· No time to serve on committees – again, there should be coverage available.  We just need to make use of it.  I have served on Housing Boards, EER Review Committees, and a Rightsizing Committee.  Our DCM OMS is currently serving on an “out of the box” committee.  

· Timing – Yes, this is an issue.  It is difficult to put your life on hold while you wait for an Ambassador to be confirmed.  However, the time can be used to get additional training and/or that additional Home Leave time we never seem to get to take advantage of.     The requirement that the AMB OMS must depart post within 60 days of the Ambassador’s departure is also difficult.  However, there are frequently ways to get around the rules or to get a waiver.  I followed the rules and left a post immediately after my Ambassador decided to retire early and curtailed.  However, the DCM was Chargé for over a year before a new Ambassador was assigned and I could easily have stayed on to work with him.

· Doesn’t guarantee promotion – No, working in a Front Office does not guarantee promotion.  However, the work is frequently more challenging and demanding.  The crises are often “closer to home” in the Front Office.  If you perform well, you should get promoted faster.  As the gentleman from the selection boards said, “It is similar to diving – your score depends on not only how well you execute the dive, but also the difficulty of the dive.”  Serving in a Front Office doesn’t guarantee promotion, but it certainly helps. 

The Importance of SOPs and Transition Notes

Kristin Rohde, OMS Kiev/Brasilia

Excerpts from Kristin’s presentation.  The complete presentation can be found on the OMS Webpage.

Kristin collected responses to a 10-question survey she wrote on OMS SOPs.  The survey was publicized via the OMS newsletter, website, listserv, and word-of-mouth.  She received a total of 80 responses which represents roughly 10% of the OMS corps.  

Survey results showed that 50% of OMSs were not left a SOP by their predecessor and 16.25% were left an outdated SOP.  In addition, 47.5% of respondents were not left transition notes.

According to the survey, the majority of respondents give a high level of importance to being left an updated SOP and/or transition notes.

78.75% of respondents said that they intend to leave an updated SOP upon leaving post.

Kristin wanted to “state”, “relate”, and “conclude” some of the more important findings from the survey.  State a higher percentage of survey respondents indicated that SOPs were not left by respondent’s predecessors, relate a significant majority of survey respondents placed a high importance on SOPs, e-files and transition notes and conclude an overwhelming majority of survey responses show a fix is on the horizon with 78.75% of respondents indicating they plan to leave a SOP for their replacement. 

Alternatively or in addition to an OMS SOP you might want to consider the following ideas:

"To-Do" List – A list that informs your replacement the priority order of pending office issues.

Transition Notes – If you’re unable to create a SOP either throughout or at the end of your tour, Transition Notes serve as better guidance than no guidance at all.  

Example Binder – A binder containing hardcopy examples of documents your replacement might find useful.  

Electronic Folder – An electronic folder saved on your section’s shared drive containing useful OMS documents officers can use during the gap and that your replacement might find useful upon arriving post.  E-file examples might be a copy of the latest diplomatic mission list, section/post/DOS contact info, post forms, latest version of the OMS SOP, file lists, etc.  

SOP Content Suggestions

Daily Routine

· Morning

· Ongoing throughout the day

· End of the day
Weekly and Bi-Weekly Tasks 

Annual Tasks 

· Fourth of July and other major post function guest lists

· Holiday gratuities

· Section subscription renewals

· File Retirement

Section Filing Procedures for Chrons, Subject, Bio and any other section files.

Post Travel Request and Reconciliation Procedures

· POC(s) for post travel agency

· Post protocol regarding blanket travel authorization and other travel requests.

· Post POC(s) for travel vouchers and voucher reconciliation.

· FY travel plan

Front Office/Alternate Section Coverage

Be sure to leave hardcopy and/or electronic guidance for Front Office or alternate section(s) you cover during times of leave or OMS gaps.

Office Equipment Tips

· Repair POC(s) for office equipment, including post protocol for work order requests.

· POC(s) for post phone system

· POC(s) for SBU computer

· POC(s) for C-LAN computer

Ongoing Tasks

· File list updates

· OMS SOP updates

· Scheduling

· Post procedures for ordering supplies or making a procurement request.  

· Frequently used e-forms

· EER and WRS management

· Post protocol for coordinating and reconciling representational events and voucher reconciliation.  

· Emergency phone tree, section contact list and other section list updates

SIPRNet

SIPRNet SOP Tips
- Print off the latest guidance/instructions posted by the PortalX support team

- Leave transition notes

- Bring to your replacement’s attention any original guidance you created. 

SIPRNet Administrator's Log

- A shared document that is passed between administrators that indicates name, date, and action taken by an administrator.  This log is helpful to keep track of when updates were done.  For things like cables, daily reports, and any other daily updates it suffices to note at the end of the week these updates were completed.  For things like annual reports, bios, visitor information, post report, link checks, etc. that are updated on a case-by-case or as updated info becomes available, special log entries are required.  At the end of the day, the log will help you evaluate how up-to-date your site is. 

Suggested Electronic Resources

Department of State Intranet : http://intranet.state.gov/
Department of State Internet : www.state.gov
Post Intranet and Internet URLs

OMS Webpage
OMS Community:  http://www.osis.gov/state/oms/
Administrator Support Group – A SIPRNet Administrator Support Group is available for all OMSs to join.  Portal X administrators provide feedback and answers to SIPRNet related questions and it’s an excellent venue to express your SIPRNet ideas. 

Livestats - Livestats is a program available for every post that has a SIPRNet website.  Livestats can provide daily, weekly, monthly statistics of how many times your site has been visited, how many hits its had, what IP addresses are accessing your site and many other helpful statistics that can assist your post in assessing a site's progress and growth.   

Kristin’s CLOSING REMARKS

The theme of this year’s conference is “ the OMS of the Future”.  I believe a way of becoming an OMS of the future is through information sharing.  If you set an OMS precedent at your post it should be documented so your replacement can carry it on, tweak it etc.  Otherwise brilliant ideas and protocols on managing the office will be lost.  By creating, maintaining, and documenting best-practice office procedures, we can evolve our specialty and become stellar OMSs of the future.  

Expanding the OMS Portfolio

Nicholas Unger, OMS Moscow

Excerpts from Nick’s presentation.  The complete Powerpoint presentation can be found on the OMS Webpage.

“If we weren’t already doing it this way, is this the way we would choose to do it?”

Trainer – Learn New Skills (then share them)

Refiner – Examine Existing Processes (fine tune)

Implementer – Offer New Solutions

If you only learn one thing…

Learn Microsoft Office and Internet Explorer, inside and out.

For the “OMS of the Future”:  this is a required baseline, not optional skills.

Intranet – http://intranet.state.gov
Ask Admin:  http://askadmin.a.state.gov
Directives Management:  http://arpsdir.a.state.gov
Employee Services Center:  http://aoprgsm.a.state.gov
Executive Secretariat:  http://ses.state.gov
HR Online:  http://hrweb.hr.state.gov/hronline
MSMC (Main State Messaging Center):  http://mso.irm.state.gov
Office of Allowances:  http://aoprals.a.state.gov/default.asp
Records Disposition Schedules:  http://infoaccess.state.gov/resources/records.asp
S/ES InfoLink:  http://ses.state.gov/exececinfolink/paper.asp
Telegrams:  http://telegrams.state.gov
Webgram:  http://telegrams.state.gov/posts/login.cfm (classified and unclassified)

Internet Links:

About:  www.about.com
EIU (Economists Intelligence Unit):  www.eiu.com.db.eiu.com
Embassy World:  www.embassyworld.com
Embajada-Online:  www.embajada-online.com
FOIA:  foia.state.gov

Google:  
www.google.com


Local.google.com/lochp



Translate.google.com/translate_t

Gov’ts on the WWW:  www.gksoft.com/govt
How Stuff Works:  www.howstuffworks.com
Operations Center:  ses.state.gov/seso/crisis/resources.asp

RefDesk:  www.refdesk.com
Rick’s Pages:  www.richardmangus.com
Llywelyn’s links:  teoma.com, dogpile.com, en.wikipedia.org/wiki/Main_Page, www.un.org
OMS “Core Courses”:

Microsoft Office 2003/XP

Web Design (Adobe/Macromedia)


Interesting “Electives”:

The 21st Century Learning Curve

Call Center / Internal Customer Service

Managing Others Through Change

Business Writing Essentials

New and expanded course catalog goes online in October!  See what’s available.

Internet Explorer – Importing and Exporting Favorites

· To share Favorites between multiple computers

· Make them available while on TDY

· Forward to a new Post

- File →  Import and Export

- Select folders to be exported

- Select location to save file to (My Documents; Desktop, etc.)

Distribution:

Upload to Yahoo! Briefcase (http://briefcase.yahoo.com)

Email to personal email (HoTMaiL, Yahoo! Mail, etc.)

Have them available when traveling or upon arrival to new post.

Microsoft Outlook

Rules Wizard

Creating Email Rules:

Move regular content to its own folder

Prioritize your incoming email

Sort things automatically

Shortcuts / Field Chooser / Personal Folders

1.  Outlook Bar:

To organize/prioritize only those folders you use most:

* Save space by not showing ones you may not use

* Save time, by putting the ones you use most right at the top

– View →  Outlook Bar

- To organize it or add the folders you use, right-click over the Outlook Bar and you can choose between large or small icons and to Add to Outlook bar…

- You can also drag the icons (that are not the actual folders themselves) up or down to put the most important ones on top

2.  Field Chooser:

-- Since most of us deal with a size limit to our mailboxes and for other reasons, it is nice to put what information we need to know in the title bar of folders such as Inbox, Sent Items, Contacts, Calendar, etc.

3. Personal Folders:

 -- In Moscow, the average In-Box will fill up and begin bouncing emails in one week!  Moving emails, manually or via In-Box Rules, to Personal Folders avoids this problem.

The Find / Advanced Find Tools

Windows Search:

- Use to find documents matching certain criteria, such as containing certain text inside the document or finding all Word documents or documents modified in a certain range of dates.

- Right-click over the Start button or go Start → Find Files or Folders

Calendar

Sharing your (or your bosses!) Calendar:

- Right click on a Calendar (note: cannot be a personal folder, must be public) and select ‘Properties’.

- Select the ‘Permissions’ Tab, then the ‘Add’ button.

- Find the person you’d like to give access to and add them to the list.

- Choose a ‘Role’ or define the individual rights to give:  Create / Read / Edit / Delete / Etc.

Once you have been granted permissions:

- Use File → Open → Other Users Folder

- Locate the Name of the User and the type of Folder (Calendar)

- Click ‘OK’

This resource will now be linked to on your File → Open menu.

Task List

Drag and Drop between e-mails, calendar, tasks and contacts:

- Drag e-mail to contact folder to create a contact

- Drag e-mail to calendar folder to create an appointment

- Drag e-mail to tasks folder to create a task

- Automatically inserts the contents of the e-mail into whatever is created

- This is good for covering yourself if things go wrong

Microsoft Word

Templates:  Cables / Memos / Faxes

Shared/Workgroup Templates:

- Saves time from repeating the same information when filling out the same form over and over

- You can tab through the fields and fill in the missing information

- Opening a template File → New or double-click when in Windows Explorer opens a copy 
- Use default text for those things that don’t change as often

- Create them with office-specific information or for each officer

- Word, Excel, & Outlook

- In order to share these templates with others, you need to create a folder that is accessible by all who will need to have access to the templates you create.  Then, you need to go into each user’s computer who has access to the shared folder where the templates are located and specify where the Workgroup Templates are located.  

Tools → Options → File Locations tab → Workgroup templates file type

Envelopes and Labels

- Use to make professional-looking envelopes, complete with a return address and a barcode on envelopes to be mailed in the U.S.

- Labels for frequently mailed addresses, such as the Foreign Ministry for Diplomatic Notes, your country’s Desk Officer back in Washington, or forwarding mail to section personnel who have moved on.

- Tools → Envelopes and Labels then click the Envelopes tab or Labels tab
- Common labels are: Avery 5163 for addresses and 5266 for file labels.

- Generally the last two digits in the Avery number is the same for each type

Track Changes

Tracking Changes to a Document for Editing:

- Helps supervisors sort through various changes to original documents so they can accept only those changes they agree with

- In newer versions of Office, especially 2003, Microsoft is concentrating a lot of their changes to the programs towards an office where several people contribute to a final document, which is the way the Foreign Service works with drafters, clearances and approvers.

- As different people make changes to a document, Word can track who did what.

- To turn on or off go to Tools → Track Changes → Highlight Changes → place a check in Track changes while editing to turn on and remove the check to turn it off.  In newer versions of Word, the Highlight Changes dialog box below doesn’t appear, but the Track Changes dialog box does. In the older versions, you can view the Track Changes dialog box by clicking Options.

Routing

Create a routing slip and start routing a document

1.  Open or create the document that you want to route.

2.  On the File menu, point to Send To, and then click Routing Recipient

3.  To select the recipients to route the document to, click Address.

4.  In the Type name or select from list box, type a recipient’s name, and then click To.  Once you’ve entered the last recipient name in the To box, click OK.

5.  You can change the order in which recipients will receive the routed document by changing the order of recipient names in the list.  Select the name of the recipient you want to move up or down in the list, and then click the appropriate arrow.

6.  To route the document right away, click Route.

7.  To route the document later, click Add Slip then (SAVE!) & close the document.

8.  For easier tracking – please give your routing slip a subject line, and if you wish to send to the recipient additional instructions or comments you can do so by typing text in the Message Box.

Auto Text / Fields

Inserting Auto Text or Fields:

- Use to show important information about a document that’s up-to-date as it changes:  date saved, date printed, document name, document file path, page numbers, total words in a document, etc.

- Insert → Auto Text and choose from all of the available options.  There are several frequently used ones in the Header and Footer section.

- To insert them into a header or footer, go to View → Header and Footer, navigate to the correct spot and Insert Auto Text entries, date or page numbering information

- Note: there are several different types of dates available that can automatically update themselves so be sure which one you want so you get the right one

- Last Printed:  obviously good for printouts to compare 2 hard-copy documents or to see online when the last time it was printed

- Current Date:  Insert → Date and Time → choose a format and check Update Automatically if you would like it to; this is only the current date if you choose to Update Automatically or, if not, then the date you inserted in the field.

- Insert → Field this has several options, but if you would like to compare when two documents were saves, as opposed to all of the other options above, click Date and Time → under Field Names SaveDate →Options → under date-time formats choose the option you like best.  I like the one with am/pm since some documents could have been saved within an hour of each other.  This is the best option whether the documents rae printed or online because it shows when it was actually saved.  

Microsoft Excel

Intended: Spreadsheets / Calculations

Types of records:

- Incoming action and informational cables

- Section and embassy outgoing cables of interest

- Important and relevant e-mails

- Biographical info: Internet articles and officer-written bio sheets

- Internet news articles

- Other records that will not be retired

Also: Simplified Databases / Logs

Possible Advantages:

-  Less hard-copy files

- Less shredding

- Faster searching

- Easier to share files, especially with large groups of people – Compare: 1 e-mail with attachments to 20+ people versus a whole lot of faxing with wrong numbers and bad copies

- Multi-generation faxes decreasing quality

- Cables not retired

- Evacuations: speedy exit for employees

Possible Disadvantages:

- You need to have a good filing system, officer participation, and naming convention or you may not be getting all of the right information and it will be harder to retire the records when the time comes.

- Not enough clear and specific guidance in FAM/FAH and Records Disposition Schedules regarding electronic filing and retiring

Microsoft PowerPoint

Useful, but focus on sharing information instead of making it look pretty.

· Pictures, Sounds, Animations should be the last thing you do.

Microsoft Access

Very powerful, but often requires more resources to create a database than the task at hand requires.

Web Design: SIPRNet

Content Varies from Post to Post - E-Grams / Cables / Etc.

Tremendous Opportunity to Grow the OMS Sphere!

File Naming Conventions

Year-Mo-Dt (Cable xxxxx) Description.doc

Keep Documents on the Server:

- Warning!  Always keep files on the server and not/not on your C:\ drive since the server is backed up daily.

- Use your section’s Shared/Network drive or your networked ‘My Documents’ folder

- For Example, Embassy Moscow policy is to not allow storage of documents on local drives.  IM will not support recovery of local files.

“You may not know all the answers, but learn how to find them!”

OMS:  Creating New Roles

TRAINER – Learn New Skills

REFINER – Examine Existing Processes

IMPLEMENTOR – Offer New Solutions

Teach your colleagues.  Learn from your peers.  Offer your knowledge.

What applies to your situation?  Not everything will.  Pick and choose.

Make things easier.  Increase efficiency / automation.  Reduce duplication.

Scanning / OCR

Optical Character Recognition

· Faster: Reduced Typing

· More Accurate: Fewer Errors

· Language Issues:  Translation, Editing

Electronic Documents

· Reduced Pouch Traffic

· Easier Archiving

Action Log

Action items

· Incoming Action (Text of Cable)

· Action Officer

· Completion Date & Response Cable

Dip Note Archive 

· Incoming / Outgoing

· Reduced Annual Shredding

Customizing Your Inbox

What I Use

Outlook Shortcuts:  Common Destinations

Folder List: Nested by Subject/Sender/Action

Inbox Rules: Move regular Traffic Out of the Way

Preview Pane:  Scan/Review/File

Everyone thinks differently.  Adapt.

“If we weren’t already doing it this way, is this the way we would choosse to do it?”

· What are your most common tasks?

· What hinders their completion?  People / Systems / Process

· What can be changed?  Method / Training

· Who do you need to talk to?  Supervisor(s) / Peers

The A Bureau – Planning for the Future

Acting Assistant Secretary Frank Coulter

Motto is “Making Diplomacy Work”

Take a look at A Bureau website

BNET now at many posts – must have adequate bandwidth

Rightsizing and Regionalization

Will Moser, Office Director, A/CAI

Changing from doing the maximum at posts to doing the minimum.  

Functions that can be performed by personnel based in the U.S. or at regional offices overseas should not be performed at post.

Plan to accomplish rightsizing at all posts by 2008.

A/GSSI intranet site – on ADMIN page

Ask ADMIN

Survey Builder

Note to self – look at ALDACS & Department Notices each day

Post Application Software Suite (PASS) 

The Software Suite for Administrative Applications

Alfred O. Haynes Jr., Branch Chief, Corporate Administrative Applications Branch

PASS PMO (IRM/OPS/SIO/APD)

PASS website - pass@irm.state.gov
Visitor Management – tracks itineraries, accommodations, etc.

Country Clearance Process – interfaces with CLOUT

Access Control – visitor access module (visitor accesses e-service module for country they are going to visit.  Make request.  Request is approved by their supervisor.

Wednesday, October 5

“Breakout Session” presentations of recommendations for Career Development Path:

Note:  As each delegate only attended two of the eight breakout sessions, my notes are limited to the two sessions I attended, as well as notes from the short briefings from the other session spokesperson.

Principles of Career Development for the Foreign Service Office Management Specialists:

Where the Career Path Principles states “after tenure” there are strong recommendations to change it to “upon entry on duty.”  We don’t believe that OMSs should be penalized and lose out on satisfying requirements during their first, and possibly second, tours. 

· Operational & Technical Effectiveness

· MANDATORY:  Obtain a minimum of 3 computer training certifications.  

If these certifications are mandatory, the Department should pay for the test, in addition to the training.  Currently the training is available on-line.  However the certification test must be done in Washington.  If it is done at post the OMS must pay for it – at $100 per test.  They should be reimbursed.

If you already have your MOUS certification it should be counted.

· ELECTIVE:  Obtain additional computer training/certifications 

· ELECTIVE:  Serve on Operational/Crisis Response duty

Need to clarify “six month” requirement.  Does that mean 180 days?

Additional recommendations for this elective – Serving as Duty Officer (probably not enough time to qualify), Floor Warden, First Responder (for at least 1 year)

· Leadership and management effectiveness;

· MANDATORY:  Take Leadership Training

There is already a mandatory EEO Course, PT225, which everyone must take.

Seven Habits is PK216 (not PT216)

· ELECTIVE:  Supervisory responsibility (documented in WRS & EER)

If we are required to have supervisory responsibility, we should be given supervisory training.  How to write WRS & EER for FSN.  

Suggestion for an additional elective in this category:  

ELECTIVE:  Community Service – minimum of 1 year.  

Serving on Housing Board, Commissary Board, School Board.  Developing and sustaining a community outreach program.  Taking a leadership role in a community outreach service.

· Sustained professional technical skills and language proficiency;

· MANDATORY:  Achieve a 3/3 in a World Language or a 2/2 in a Hard or Super hard Language as tested by FSI (depending on when tenured)

Typo -  “All OMS tenured after January 2006 must achieve………….all OMS tenured before January 2005 must achieve………”   should probably be “before January 2006.

Will FSI be able to handle the extra classes necessary?  Post language programs also an option.

Need to increase Rover pool or WAE availability in order to allow time for training.

Must improve reliability & usability of Fastrack

Offer more regional training.

· ELECTIVE:  Cross-functional experience or out-of-skill-cone assignment

Too limited.  Need more opportunities and better advertisement of the opportunities available.

Cross-functional excursion tours should have possible natural progression to career change

· ELECTIVE:  Professional development and training (minimum of two additional management courses)(e.g. Interpersonal and/or teamwork skills training.)

Must be given the time to take these classes.

If post pays for outside vendor training they should always request a certification process in order to add it to our PAR

· ELECTIVE:  Professionally related training at a school of higher education

· Responsiveness to Service needs

· MANDATORY:  Service at a 15% or greater hardship/differential/danger pay post

With “Fair Share” we still have to bid on a hardship post every 8 years.

· ELECTIVE:  Serve in Executive Offices as OMS to COM, DCM, Under Secretary, Assistant Secretary or DAS

· ELECTIVE:  Serve in an officially designated Critical Needs position

· Serve one tour at an unaccompanied post

The OMS Career Development Path

Director General Ambassador W. Robert Pearson and Panel Members: 

Hans Klemm, CDA Director

J. Christian Kennedy, HR Office of Performance Evaluation (HR/PE)

Larry Nix and Chet Phillips, Office of Resource Mgt & Organization Analysis (HR/RMA)

Joyce Harley, Office Management Specialist, S/ES-EX

SUMMARY: The OMS Career Development Path – The delegates had the opportunity to share their thoughts and concerns about the new CDP with a distinguished panel led by Director General Robert Pearson.  The panel stressed that the Career Development Program is not a “check the box” process.  Promotion will still be based on performance.  The panel was very receptive to the delegates’ recommendations, especially concerning enhanced training opportunities.  They also commended the OMS corps for embracing the additional responsibilities of being SIPRNet managers.  They are still seeking additional input for the CDP, but hope to have the CDP effective in January of 2006. 

NOTE:  This text is derived from hand-written notes and is, therefore, not verbatim.


Hans Klemm opened by stating that, in his opinion, the Career Development Program was the biggest change to the Foreign Service since the passage of the 1980 Foreign Service Act.

He said that they first worked on the Generalist portion, and that prior to this program the only requirement that a Junior Officer had to fulfill in order to reach top levels was to reach a 3/3 level in a language, even if he/she had met that language requirement prior to entry into service.

The Career Development Program sets out new structures of training/career milestones that must now be met in order to show that one has the skills necessary to achieve these top levels.   

He said the Department is now working on the portion of the Career Development Program for Specialists and they are eager to hear our views.  

He then introduced the driving force and inspiration behind the new Career Development Program, Director General Pearson.

DG Pearson said that he felt it to be a privilege to have the opportunity to speak with the highly valued members of our Corps.

He said that the Career Development Program for OMS is rooted in the requirement to meet the needs of tomorrow for the Foreign Service.  He went on to say that our work force has lots of talents and abilities that are not being tapped, and that the Career Development Program, geared to each of the specialties, will enable us to contribute more effectively and to strengthen those skills and abilities.

The DG said there will continue to be OMS promotion opportunities up to the 03 level.  The total number of 03 specialists promoted has doubled since the year 2000 from 15 to 34.  The State Department OMS grade levels are linked to the Civil Service grade levels, of which the highest is a GS-10, after which they move into Staff Assistant or Special Assistant grades.

State Department OMS grades actually go higher than the Civil Service grades, due to the special skills demonstrated by the Foreign Service OMS.

Some FS OMS may want to explore career paths in other areas, and the DG stated that they are looking at greater flexibility in those areas, although he stressed that he is certainly not encouraging people to leave the OMS field.

DG Pearson noted two innovations of the new Career Development Program geared toward enhancing our career choice.  They are looking at ways to give compensation to people who serve as Special Assistants or in higher level Front Office positions, and also at the possibility of incentives for foreign language skill proficiency.

He stressed that the Career Development Program is not/not a new name for banding, and that the Career Development Program for Specialists, as for generalists, is not a “check the box” process.  Promotion will still be based on performance.

The DG said they look forward to hearing our feedback in this meeting.  They will then send another message to the field with the updated draft Career Development Program and to request additional feedback from the field.  They hope to have the plan effective as of January 2006.

The DG then introduced the panel, and opened the floor for questions and/or comments.

Q)
We appreciate the “grandfather” scheme in the plan, as some of us are running short on time to fulfill all of the requirements.

A) DG -
This feature is also in the Career Development Program for generalists, as well as specialists.

Q)
We are looking positively at the training opportunities, but are concerned that the losing/gaining posts may still not allow for the timing of such training.

A) DG -
We have talked to FSI; I have personally briefed the Secretary; we have requested major budget increases for FSI.  Posts need to properly classify Language Designated Positions; I have talked to Posts in my travels and stressed the need to allow time for training.  I will assure we have the resources. However, we need to first set the requirements in order to obtain the resources.  I definitely believe that the ability of an OMS with language abilities makes a definite difference at Post.

Q)
In our discussion groups several of us had concerns with the “after tenure” requirement on many of the mandatory and elective requirements.  For example, we believe that those whose first tour is at a hardship post should get credit for it.

A) Christian Kennedy – Our number one criteria is to look at where we have our needs in the service.  We put “after tenure” because we have so many hardship positions that we want to have staffed by experienced mid-level employees.

A) DG – We need experienced people to serve at hardship posts.  We have confidence in your abilities.

Q)
Regarding your comment on the increased number of promotions – is this throughout all specialists, or just OMS?  When you look at the percentages of promotions there are far more officers promoted than specialists, especially OMS.  Why the disparity?

A) DG – We do a work force planning module to determine the requirement for secretarial functions in the Foreign Service and we compare it with the Civil Service.  Foreign Service 4s and 3s are already beyond the grade level of their Civil Service counterparts.  The Civil Service secretary to Secretary Rice is only the equivalent of a FS-3.  We will try to expand the possibilities for promotion, but we can’t get a grade structure higher than it is now.

That said, people come into the Foreign Service with a great deal of skills.  If you are unhappy with the promotion cap for OMS, you might consider moving to another skill code.

Promotion rates differ because of the models run each year.  The model considers the requirements of the service and we make promotions based on the vacancies available.  More promotions would leave us with far too many people at higher grades than there are positions available for them.

We can, however, open up greater possibilities for other opportunities, such as language & technical training.

A) Chet Phillips – Over the past 10 years there has been a decrease in the “time-in-class.”

Q)
Some of the electives can be achieved by a Washington assignment.  However, a D.C. tour is prohibitively expensive and an extreme hardship, especially for a single, entry-level OMS.  Is the 6/8 rule being enforced?

A) DG – You can’t be prepared for doing your best job without having some D.C. experience.  As a professional you really do need some D.C. time.  You need to see how this building, and the rest of the Government, operates in order to do your best job.

A) Joyce Harley – There are ways to come back to D.C. and survive, such as working on the Line.  You do need to have D.C. experience.  It is also a great networking experience.

OMS follow-up – I agree.  I would love to serve in D.C.  However, at our pay grade it would be difficult financially.  I don’t think it should be a forced option. 

A) DG – We will be happy to look at the issue.  For a Junior Officer to come back to D.C. with a family on a FS-3 salary is also difficult.

A) Hans Klemm – The 6/8 rule is actually to limit D.C. time.  The requirement to serve no more than 15 consecutive years overseas is a provision of the Foreign Service law that has never been enforced.  It is a recommendation and is encouraged, but it is not a requirement.  Nevertheless, we do need to staff Washington positions.

Q)
My question is how to get the OMS to step up to the plate and serve in the Front Office.  Perhaps you can have an OMS speak to Ambassadors at their training seminar.  Also, could you consider compensation for a grade 6 or 5 working for an Ambassador?

A) DG – Having an OMS speak to the Ambassadorial Seminar is a very good idea.  We will work on it.  

We are looking at the issue of compensation as an incentive to encourage people to work in Front Offices.  

We are also looking at language incentives for Front Office positions.

Q)
Might we possibly include in the mandatory or elective requirements training specific for different positions, for example for an AMB OMS or RSO OMS?

A) Christian Kennedy – the Career Development Plan encourages people to take the widest variety of jobs.  Job specific training is an excellent idea that we will take to FSI.

Follow-up - DG – What time frame are you thinking of for this training?  3 days…a week?

A) OMS follow-up – Two to three days should be enough to introduce the portfolio with which one would be working.

Follow-up – Peg Cross – Would that training necessarily need to be in the classroom, or could it be distance or “post” training?

A) OMS follow-up – I believe it would be more effective in the classroom.

Q)
What about the possibility of additional skill codes for Political or Econ OMS as an alternative career track?  For example, at the FS-05 level they could be Political or Economic Specialists.  

Also, for those who do the Functional Specialization skill code change, could we perhaps have a Consular track, in addition to GSO, HR & FMO?

A) DG - 
We will look into it.  I have not previously thought of inventing new specialties for conversion.

Q) 
As a new-hire, I have been impressed with the backgrounds of my colleagues.  I have a question from a colleague at post who has a Masters in Administration and to whom the Foreign Service is a 2nd career.  Is there any way to have one’s previous education take the place of the educational class requirements in the new Career Development Plan?

A) Christian Kennedy – That is a very good idea.  We will explore it further.

Q)
I have a question regarding “critical needs positions.”  We understand that there are currently no OMS positions designated as critical need, so how can we satisfy that requirement in the new Career Development Program?

A) Hans Klemm – “Critical Needs” is a new feature to the Foreign Service.  It was created for the generalists Career Development Program and there are 200 positions in the current cycle.  As the Specialist Program has not yet been completed no positions have yet been designated.  We will have Critical Needs OMS positions for the 2007 cycle.

Q)
There are a very limited number of examples of “critical needs” positions listed in the Career Development Program.  Will there be more?

A) DG - 
Just as for Generalists, we don’t know in advance which positions will be classified as “critical needs.”  We will go to all of the Bureaus to decide on which of their OMS positions will qualify.  If you serve in one of these positions it will make a significant contribution to the Department.  However, we won’t require you do anything that is impossible to do.

Q)
Has any thought been given to expanding the skill codes?  Many OMS are serving as SIPRNET managers.  Do you foresee a possible skill code change for them?

A) DG - 
I don’t know about a skill code change, but we are looking at the additional responsibilities.

Follow-up - 
It is rare to find Public Diplomacy OMS positions.  With our website manager experience it would be good to have more PD OMS jobs available.

DG follow-up - 
Which brings up a good question.  How many of you here are acting as webmasters for virtual posts?  

(There were two OMS in the group who are, indeed, acting as webmasters for virtual posts.)

Q)
I am looking at 9 years until mandatory retirement and want as fulfilling a career as possible.  However, the 3 years waiting for tenure limit me.  Any recommendation on how “short timers” can achieve as much as possible, and see as much of the world as possible?

A) DG - 
I appreciate 2nd career folks and want to make the most of their talents.  However, service needs determine career patterns.  We will probably keep the requirement for the number of years personnel are required to stay at post.

A) Joyce Harley - 
I suggest you take a good look at what you want to accomplish and work with your CDO to devise a career path that fits your own personal goals.  If it is promotion you are looking for, note that the years before tenure are counted toward promotion.  There are some positions that require you to be tenured, but not many.

Follow-up – Hans Klemm – Back to the SIPRNet/webmaster duties.  We realize that they take a lot of time and it is a big responsibility.  We strongly encourage you to make sure these duties are listed on your Work Requirement Statement and described in your EER.

Q)
Regarding having an OMS speak to the Ambassadorial Seminar, I heard a rumor that the A100 class has as one of their topics “how to work with the OMS.”  Is that so?

A) Hans Klemm – In our travels around the world we have heard that many Junior Officers could use a little more “polishing.”  If it is not already being done, we will suggest it to FSI.

OMS Follow-up – I did sit in one a class on “how to work with the Front Office.”

Q)
The new Career Development Plan requires Microsoft Office Users Suite (MOUS) certifications.  Will previous certifications count?  I thought perhaps the reason the plan says “after tenure” is so that if you don’t have the certificates on entry, you don’t need to focus on that requirement until after tenure.  Is that correct?

Also, if we have to pay for our MOUS certifications, will we be reimbursed?  

We need more training available at our fingertips – not just at FSI.  Perhaps you could provide more regional training.

A) DG - 
OMS professionals should be able to keep up with and successfully test in the basic software requirements.  We will look at all possibilities to provide training.

A) Christian Kennedy – Many of these programs have “distance learning” training available through FSI.  We will work with the trainers at FSI to ensure you have what you need.

OMS - 
Thank you for your support.  A lot of issues have been addressed.

OMS - 
I to am encouraged by your support.  Please make sure that Posts and Bureaus are funded for the necessary training and travel.

DG -
Thank you for helping us frame your profession.  My job is to facilitate what you, collectively, decide.  If you get together as a group and come to Management collectively with requests it will carry more weight than if you come individually.  We have the opportunity to frame our own career paths.

You stress training.  We have to first set the criteria to request the training in order to get the resources.  There is no guarantee we can satisfy all or the requirements all of the time.  However, we have enough people on board now to provide coverage so that training is an integrated part of everyone’s career.

Hans Klemm – In closing on behalf of the DG and the panel, your feedback is very important to us.  Please continue to formally give us feedback through the channels available (listed in the cable – HRPEResponses@state.gov).  Thank you for giving us this time to spend with you.

The Future Role of the Office Management Specialist

Jay Anania, Acting CIO, Bureau of Information Resource Management

How IRM & OMS will interact

Secretary Rice’s “Transformational Diplomacy” is not doing “business as usual.”  It means doing things in a different way.

Rightsizing – What can we do for posts to take work away; free them up for more important things.

Opennet Everywhere – a new program. 

Wherever you are, your job is to add value to whatever you do.

Website managers (not Webmasters.  Webmasters are more technical.)

We need to be able to explain to technical people what it is the office needs.  

We need to be able to explain to officers/TDYers how things work.

OMS comment – We propose that IRM send out an ALDAC message that OMSs who have the skills and wish to manage the SIPRNet site at post can do so.

Mr. Anania endorsed the concept and said he will collaborate with others to get this done.  SIPRNet sites should be managed by “content managers.”  Portal-X is not intended to be run by IMers – it is not a “technical” thing.

PKI/Blade – IRM/OPS/ITI/SI/PKI

http://pki.irm.state.gov
The goal is for all posts to be PKI enabled by the end of 2006.

Excerpts from Handout – What the Heck is PKI and What Will it Do for Me?

PKI stands for Public Key Infrastructure.  It is as system of digital keys and certificates that provide security for a wide range of electronic communications.  The PKI keys and certificates reside on the new SmartID badges that DS is using to replace the old State Department badges.  The SmartID badges will give you physical access to State buildings and, eventually, your OpenNet computer accounts.

Right now, the DoS PKI is being used to digitally sign and encrypt emails.  Federal legislation requires that sensitive information, like personal medical data or social security numbers, be protected.  PKI uses encryption to provide information privacy.

Other legislation, like the now famous Government Paperwork Elimination Act (GPEA), requires digital signatures on official documents.  

PKI is also being used to provide secure access to applications all over the State Department.  Below are some examples of applications that will soon require PKI:

E-FORMS – The replacement of InfoForms.  The over 1,400 official forms State Department uses will be replaced with forms that can be digitally signed.  EERs, Leave Request Forms, etc.

Secure Dial-In (SDI) – This is the new remote laptop system that will allow personnel to work from home or on the road.  It uses the PKI on the SmartID badge to log onto the laptop.  PKI also protects the information on the laptop rendering it useless in the event of theft or loss.

Biometrics Logical Access Development and Execution (BLADE) – This system will integrate biometrics (finger print) with PKI to allow you to log onto OpenNet without a UserID and password.  

Financial System – PKI will eventually replace the legacy encryption system that protects financial data sent over the internet.

Mainframes – PKI is being used to strongly prove the identity of mainframe system users, as well as protect the privacy of sensitive data.

PowerPoint presentation Summary (IRM/OPS/ITI/SI):  

· BLADE/PKI will help DoS strengthen IT security & access control to State computer network systems.

· Biometrics & PKI are mutually supporting and both are stored on the Smart Cards to provide added security

· BLADE/PKI facilitates implementation of federal mandates

· GPEA, E-SIGN, HIPAA, etc.

· This integrated technology will support multiple interests in world-wide environment at reasonable cost accuracy and acceptance.

State Messaging & Archival Retrieval Toolset (SMART)

Charles Wisecarver, SMART Program Manager

Barry Fulton, Change Mgt Consultant & Research Professor, George Washington U.

Paul Converti, Northrup Grumman

E-mails are being used at a ratio of 60 to 1 over cables - - problem is they are not being captured/archived.

SMART will replace current cable & e-mail system.  SMART has multi-media capabilities.

You will work from the same monitor, with a box to switch from the high side to the low side.

Users control what they see.  You can set up an “organizational profile” with what you must see, and an “interest profile” with what interests you (e.g. cables from your last post).

“Need to Know” is no longer valid.  We now work on a “Need to Share” basis (except, of course, private information channels such as DS & Med).

Formal e-documents – in final (currently cables); Working e-documents (currently e-mails);

Personal e-mail

Instant messaging will be available on the high side – able to have a “classified” conversation, & then save it to a document.

Training will be available on line.

OpenNet Everywhere (ONE) for teleworking and Blackberry for mobile coputing

Messaging Systems Office, Bureau of Information Resource Management

Messaging System Products (MSP):

OpenNet Everywhere (ONE) – one.irm.state.gov


Uses a Fob to access your SBU e-mail from home.  You cannot print.  Must have a 


compatible version of Java.  Currently only available domestically, & strictly controlled 


through HR.

Secure Dial-In (SDI) – provides the ability to call from home to check your e-mail.  Seven posts 


already on board.  Five posts currently testing.

Blackberry Enterprise Solution (BES) – e-mail Blackberryproject on the GAL


Only certain versions of the Blackberry are authorized

Thursday, October 6

Office Management Specialists – The First Line of Defense

Dale Orr, Office of Information Assurance (IRM)

The State Department collects and stores 100% of the information coming across its system.

The ISSO job is to ensure and to balance confidentiality, availability and integrity.

Highly recommend you NOT use the preview view, no matter how handy it is.  Many “bugs” can get into the system without you actually clicking on it to open it. 

Any questionable e-mails, right click on the message & forward to Spam@state.gov
Or, if there are a number of them, drag & click them to a new e-mail and forward it instead.

If you get an e-mail from a reputable company that looks “fishy” forward it to 

Fraud@ebay.com or fraud@amazon.com, etc.

Anything strange going on with your computer should be reported to the ISSO.  

Lock your computer when you leave your desk, even just for a few minutes.  A quick way to do this in XP is to use the “window” key located between Control & Alt.  Click the window key & L at the same time to lock the computer.  (Other great uses of the “window” key – Window + D gives you a view of your desktop.  Window + E gives you a view of shared folders.  Window + F brings up the Find (search) function.).

OMS and Community Webpages

Shirley Adams, Office of E-Diplomacy

The OMS webpage is a reference tool – a file cabinet, if you will, of useful information.  All information for the OMS webpage must be submitted to OMSwebmaster@state.gov.

The OMS Community of Practice (COP) “Blog” is a site, which can be accessed through the OMS webpage, as well as through the eDiplomacy webpage, where you can personally submit your own thoughts and ideas or respond to those of others.  It is a common meeting room – a common workspace, so to speak, where you can be proactive.  

Eric M. Johnson created the blog site.  Current OMS webmaster Shirley Adams maintains it.

Note to self – Try to look at OMS Webpage and OMS COP Blog at least once a week.

Panel Discussion:  The OMS and Information Expertise

Gary Galloway, Shirley Adams, Joni Taylor, Bruce Burton – Office of E-Diplomacy

Although the original concept was for SIPRNet sites to be managed by Junior Officers, in reality, most of them are being managed by OMS.  Some of the better ones to take a look at are Tel Aviv, Cairo, London.

Policy making is at the top of a pyramid that begins with having the DATA to perform the ANALYSIS to have the KNOWLEDGE to create the POLICY.

Portal X software is used to manage the SIPRNet.  Portal X 1.3 will be rolling out next year.

OMS need to learn IT systems.  Some posts have low band width issues, but sometimes proxy settings are actually the problem.

Go to IRM info center on the GAL to report problems.

SIPRNet e-mail distribution list group – sign up with Shirley Adams.

Look at the Knowledge Leadership Page on the e-diplomacy site.

What good is information if you don’t share it?  May need Ambassador’s “push” to get other agencies to share their information for the SIPRNet site.  (Look at Tel Aviv SIPRNet site – they add DAO reporting to their site.)

DO put unclassified info on the classified SIPRNet site as well.  There is plenty of space.  Don’t worry about duplicating info that is also on the unclass side.  People would prefer to be able to look in just one place whenever possible.

AFSA – Who We Are and What We Do for You

AFSA Vice President Steven Kashkett & James Yorke

The recent AFSA on-line survey showed that the single most important issue to AFSA members is the Overseas comparability pay.

The second most important issue is unfairness in the promotion and assignment process.

Regarding A&T benefits (or lack thereof) and the inequality by grades of housing assignments and HHE allotments – AFSA has raised these issues in the past, and will do so again.

AFSA asks that AFSA reps at post, or OMS, let AFSA know when CODELS are scheduled to visit posts.

Distance Learning Opportunities through FSI

Beth Nolte, Distance Learning Coordinator, Office of the Registrar, FSI

http://fsi.state.gov/fastrac
FasTrac Distance Learning – Web-Based Training Program

FasTrac is a government-wide distance learning program designed for busy working professionals.  Available through the Internet, FasTrac lets you take courses at home or work, whenever or wherever it is convenient for you.  Courses take from two to eight hours to complete.  You can train effectively in as little as 15-minute increments.  FasTrac is offered at no charge to all Department of State Foreign Service and Civil Service Employees, Locally Employed Staff, Personal Services Contractors and Eligible Family Members.

· Coordinate a learning plan with your supervisor; take as many courses as you like.

· Choose from thousands of courses in over 50 different topic areas.

· Post completed courses to your official FSI training record.

· Attend class whenever you want, wherever you want (must disable Pop-up blocker if doing it on your home computer), and at your own pace.

· Keep a ready reference library right at your fingertips.

· Obtain college credits or continuing education units (CEUs).

· Prepare for Technical Certification exams.

· Apply your learning immediately to your career.

1. Go online to http://fsi.state.gov/fastrac (OpenNet) to browse the FasTrac catalog and apply.

2. Complete the online DS-755 electronically, or fax your training request to the Office of the Registrar (Fax: 703-302-7152).

3. You will receive your logon and password and you are on your way.  Supervisory approval is no longer required to apply for FasTrac courses.

Distance Learning classes other than FasTrac still require supervisor approval.  Must submit a DS755 Request for Training (one for each FSI class).  

On-Line courses are also available to EFMs.  EFMs who are working should submit their DS755 through their supervisor.  Beth Nolte would give supervisory approval for EFMs who aren’t working.

The School of Applied Information Technology (SAIT) and the School of Professional and Area Studies (SPAS) offer Foreign Service Office Management Specialists and Civil Service Office Support Professionals the opportunity to acquire their MOS Certification - see Department Notice # 2005-02-072.

Classes can be taken at FSI and include Certification testing; or, classes can be taken through FasTrac.  Fax your passing grade information to Muhammad Yusuf and he will fax your course certificate to you and also assist you in scheduling your MOS certification test the next time you are in Washington.

For more information, study the Department Notice or e-mail Margaret Riccardelli in FSI/SPAS/OMT.
The OMS and Security in a post-9/11 Embassy

Joe Morton, Principal Deputy Assistant Secretary for Diplomatic Security, and 

Director, Diplomatic Security Service (DS/DSS) 

RSOs are Federal Law Enforcement Officers, not “just” Security Officers.

Don’t Blow Off Drills!!!!   Drills Can Save Lives!!!

Working on plans to provide more training for RSO OMS to help lessen the burden on RSOs.

Reviewing staffing levels in all RSO offices, as well as grade levels of positions.

Diplomatic Security Anti-Terrorism Course (DSAC) Hopefully someday soon everyone will have the opportunity to take it. 

(Clarification Note:  There are really two of these.  There is the original which was generally called the "crash and bang class" which was given to employees and dependents going to high threat (more than 15% danger pay) posts.  There is Iraq specific version of this which is longer and covers more things such as emergency first aid and IED's along with weapons training.

Panel Discussion:  You and the Assignments Process

CDOs Claudia Romeo, Elizabeth Orlowski, Loretta Hight, Ellen Haines and Peggy Conlon

Deputy NEA Assignments Officer Joseph Bedessem

Personnel Technician Pamela Aulton

Discussion on how the assignments process works.

Friday, October 7

A New Way to Library

Michelle Brosius, Reference Librarian, Ralph J. Bunche Library

http://infoaccess.sate.gov/library
E-Mail Address: Library@state.gov
Access to newspapers, magazines

Treaties & International Agreements

Databases  

Leadership Directories on-line

Congressional Books (save post money – don’t order these books for the office anymore)

Biographies

Newspaper Direct Foreign News (only papers labeled “smart” can bring up graphic articles that can be printed and or translated)

E-Books – www.netlibrary.com
Must create a free account on OpenNet Plus, then can access from home.

Expanded Roles for OMSs:  Skills You’ll Need to Succeed

Harry Ponting and Frederic Hassani, Office of Intelligence Resources and Planning 

(RM/IRP/CIP)

Don’t need to cook the turkey without the legs anymore.  (inside joke)

Just because it’s always been done that way doesn’t mean we have to continue doing it that way.

New technology allows us to do things differently…..and better.

Net Centric Diplomacy – streamlined publishing to classified website.  

Make information available to ALL.  99% of all cables should be put on SIPRNet.

To move a cable from CableXpress – 

Select cable, Assign term(s) and link to “Hot Topic” if desired, Click “upload” to post to site

Need to prioritize the bios we want to put on the SIPRNet site.  CIA will still have the most up-to-date bios.  Should be able to link.

SIPDIS – new caption has been approved to automatically move cables to the SIPRNet site.

Order Digital Classified scanner (AR507 or 407).  Very expensive.  

Do NOT plus into unclassified system.

In the Future –

Net Centric Diplomacy File -- 

Shared electronic filing cabinet.  Replication using tags & terms, chron, bios.

What do Diplomats do?  Filter, File, Discuss, Decide, Pen, Publish

In the “real world” now – 

Filter/File:  Del.icio.us – A social bookmarks manager.  Using bookmarklets, you can add bookmarks to your list and categorize them.

Discuss/Decide:  Slashdot.org - - (news for nerds).  Can post articles, along with your comments.  Others can add comments.  Cyber-evolution – survival of the fittest.

Pen/Publish: Wikipedia  - - the biggest open-access encyclopedia on the internet.  Anyone can contribute or edit articles.  For example, following is the information found when searching SIPRNet on Wikipedia:

From Wikipedia, the free encyclopedia.

The SIPRNet (Secret Internet Protocol Router Network) is a system of interconnected computer networks used by the U.S. Department of Defense to transmit classified information (up to and including information classified SECRET//NOFORN) by packet switching over the TCP/IP protocols in a "completely secure" environment. It also provides services such as hypertext documents and electronic mail. In other words, the SIPRNet is the DoD’s classified version of the civilian Internet and together with its counterpart, the TOP SECRET/SCI Joint Worldwide Intelligence Communications System, JWICS, are revolutionizing the way classified information is disseminated to consumers.

Except for existing within a secure environment, the SIPRNet is virtually indistinguishable from the Internet to the user. Among its many features, computers cleared for SIPRNet access connect to the network via secure dial-up or LAN connections, access web pages written in standard HTML using a normal web browser such as Internet Explorer or Netscape Navigator, can upload and download files via FTP connections, and can send or receive email messages through SMTP services using email programs such as Microsoft Outlook. All data transmitted on SIPRNet between secure facilities must be encrypted by approved NSA encryption systems. While the public Internet can be used to transmit encrypted SIPRNet packets, no access is permitted between the two networks.

SIPRNet hosts a forum called CAVNET which is used in Iraq to share TTP (Tactic, Technique, Procedures) data.

SIPRNet is the DOD’s largest interoperable command and control data network, supporting the Global Command and Control System (GCCS), the Defense Message System (DMS), collaborative planning and numerous other classified warfighter applications. A parallel network, NIPRNET, the Non-secure Internet Protocol Router Network, provides seamless interoperability for unclassifed combat support applications, as well as controlled access to the public Internet. Direct connection data rates range from 56 kbit/s to 155 Mbit/s. Remote dial-up services are available up to 56 kbit/s. Direct connection data rates range from 56 kbit/s to 155 Mbit/s for the NIPRNet, and up to 45 Mbit/s for the SIPRNet. Remote dial-up services are also available, ranging from 19.2 kbit/s on SIPRNet to 56 kbit/s on NIPRNet.

You can practice on Wikipedia in the “sandbox.”

What do we need to do?

Learn new tools/skills

· Portal X

· Net Centric Diplomacy (NCD)

· Wikipedia

· Blogs

Fill the void – do not ask permission – just do it!

Follow-up note:  Following the Conference Harry Ponting sent all of the delegates a very informative e-mail on the classified system with some good suggestions and links.   

Wrap Up Panel Session

Elezabeth Veghte, Ellen Brooks, Sarah Mendenhall, Roland Elliott

Panel members summarized what we learned during the conference in relation to the OMS Career Path Principles, Leadership & Management, Needs of the Service, Technology, and Operational Effectiveness

New ideas/recommendations – 

Be sure to present post management with a long-term and short-term plan for achieving the training needed – funds, coverage, regional training, at post or distance learning training.

Ask DCM to be mentor for OMS group.

Sarah will put something on the OMS blog to get input/justifications for upgrading RSO OMS positions.

